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Important Note: The inclusion of references to any particular operating system does not guarantee full 
compatibility with such systems. Please refer to the outer package of this software to confirm the suitable 
systems.

The following Help Topics are available:

General Windows 3.1 Trouble Shooting 
General Windows 95/98 Trouble Shooting 

Other Useful Information 

Contacting Technical Support 



General Windows 95/98 Trouble Shooting
This topic presents some steps you can take before you contact Technical Support. Please open the File 
menu and click Print Topic. A hard copy of this topic is useful, since you will be working with your system 
and restarting your computer.

Before starting this guide please ensure that your machine meets the minimum system requirements 
stated on the Learning Company software package.

*********************************** CAUTION - DISCLAIMER ***********************************
NOTICE: The Learning Company, Inc. will not be responsible for any damage or other consequences 
resulting from changes made to system configuration files. You make any changes at your own risk. Even 
if you are familiar with modifying your system and/or files, we recommend you make backup copies of any
files you intend to modify.
*********************************** CAUTION - DISCLAIMER ***********************************

1. CLOSE PROGRAM BOX
Check for other programs running in the background. This is the most common cause of problems you 
may encounter. To open the Close Program Box press Ctrl+Alt+Del (just once).

If the Close Program Box lists anything other than Explorer and Systray, highlight the item and click the 
End Task button. This temporarily unloads the program from memory, until you restart Windows. Repeat 
this procedure as necessary, until only Explorer and Systray are left. At this point, it is advisable to 
uninstall and reinstall the program as per section 7 of this guide.

This should fix the majority of problems although if you still have problems then follow through 
the rest of this guide.

2. CHECKING THE HARD DRIVE FOR PROBLEMS

A.    Run the program Scandisk on the C: drive (and the drive where this program is installed, if it is not 
drive C:). To run Scandisk, click from the Start menu, to Programs, to Accessories, to System 
Tools, to Scandisk. Fix any problems Scandisk detects.



B.    Run the program Disk Defragmenter on the C: drive (and the drive where this program is installed, if
it is not drive C:). To run Disk Defragmenter, click from the Start menu, to Programs, to 
Accessories, to System Tools, to Disk Defragmenter. If your hard drive is fragmented by even 1%
it is important to run this program. Click Start to proceed.

Note: If Scandisk or Disk Defragmenter is not a option from your Start menu, then this utility may not be 
installed in your machine. Consult your Windows documentation for installation instructions.

3. CHECKING THE SYSTEM FILES

Caution: The following steps walk you through editing some of your computer's configuration files. 
Caution should be used.

From the Start menu, select Run. In the Open command line, type SYSEDIT and press Enter.

SYSEDIT displays the contents of your AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, SYSTEM.INI, and other
miscellaneous .INI files.

A.    In the AUTOEXEC.BAT, see if you have a SET TEMP= statement.    Some examples are below:

                          SET TEMP=C:\WINDOWS\TEMP
                          SET TEMP=C:\DOS\TEMP
                 SET TEMP=C:\TEMP

If this line is listed in your AUTOEXEC.BAT, make sure that it refers to a temporary directory 
name like "TEMP" and not an application directory like SET TEMP=C:\DOS.    

** If the SET TEMP= statement is not in your AUTOEXEC.BAT, Windows 95/98 default this 
setting to SET TEMP=C:\WINDOWS\TEMP. If this is the case, please proceed to section B **

Also make sure this "unique" directory name exist on the hard drive. For the SET TEMP= line to 
work, the directory must exist. Verify the directory exists, by doing the following:



Go into Windows Explorer (click on START, go to Programs, and double click on Windows 
Explorer).    The directories on drive C: should appear on the left side of the screen.    Look for a 
directory with the same name / path as the one which follows SET TEMP=.

Example:    If SET TEMP=C:\WINDOWS\TEMP is in your AUTOEXEC.BAT:    In Explorer, double-
click the Windows folder and look for another folder called TEMP.    If this does not exist then click 
on the FILE pulldown menu (in the Windows Explorer Window), go to NEW and choose FOLDER.
Now type in the name of the "unique" directory as listed in the SET TEMP= line.

B.    If the SET TEMP does not exist or after verifying the SET TEMP parameter is set to a unique 
directory name that exists on the hard drive, make certain this directory does not contain any files. To do 
this, double-click on the folder specified by SET TEMP=, or open Windows Explorer and open the 
Windows\Temp folder if the SET TEMP line did not exist, then drag any files listed in it to the Windows 
95/98 Recycle Bin with the exception of any files you have personally stored there; remove these files to 
another directory.
                        

If you made changes to the AUTOEXEC.BAT file, then Click on the FILE pulldown menu (in the 
SYSEDIT Window) and choose SAVE.

    
C.    In the CONFIG.SYS, see if you have FILES= & BUFFERS= lines. In Windows 95/98 these lines are 
NOT necessary as they are pre-loaded through the IO.SYS, but if they are listed, make sure there values 
are not below Microsoft's defaults of FILES=60 & BUFFERS=30. These values can be higher, but lower 
values could cause memory problems.

If you made changes, then Click on the FILE pulldown menu (in the SYSEDIT Window) and choose 
SAVE.

D.    In the WIN.INI, under the [WINDOWS] section, look for the LOAD= &    RUN= lines.    When Windows 
95/98 loads up, these lines MAY load up extra drivers / programs into Windows that might not show up in 
the Close Program Box.

If these lines are not empty, then temporarily REMark them out. At the beginning of the line place a ';'.

    Example:            LOAD=C:\MSINPUT\POINTER.EXE      NAVTSR          becomes
                                            ;LOAD=C:\MSINPUT\POINTER.EXE      NAVTSR 

If changes were made, then Click on the FILE pulldown menu (in the SYSEDIT Window) and choose 
SAVE, then click FILE again, and choose EXIT.    If no changes were made, click FILE then choose EXIT.

4. RESTART MACHINE (SHIFT KEY OPTION)

Even if you didn't make any changes, restart your machine now. From the Start menu, click Shut Down, 
then choose the Restart The Computer? option. When you see the Windows logo appear, hold down the
left Shift key, until Windows fully loads. This helps prevent some memory resident programs from loading 
into Windows.

Note: This is not the same as booting into Safe Mode.

5. CHECKING FREE HARD DRIVE SPACE
Open My Computer and right-click the hard drive icon (usually the C: drive or the drive where Windows 



is installed). Click Properties. The Properties window appears.

Make sure there is about 30 MB of free uncompressed hard drive space. Windows uses this free hard 
drive space to create "Virtual Memory" for the program to run.

6. CHECKING VIDEO DISPLAY DRIVER

Click from the Start menu, to Settings, to Control Panel. In the Control Panel window, double click the 
Display icon. In the Display Properties window, click the Settings tab. The Display Properties window 
refreshes as shown below.

Note: Take extreme caution in making any changes to your video card drivers. Unless you are familiar 
with changing your display driver, The Learning Company strongly recommends following the instructions 
as outlined in your video card manual or contacting the video card manufacturer or computer company for
assistance. If you choose a incorrect video card driver, you may find your Windows screen corrupted.



Please take steps A, B, and C below.

A. Verify you are running in the correct resolution/colours. Most Windows programs run in either    
800x600 256 colours or 640x480 256 colours). Check the system requirements for the The Learning 
Company program you are running and make sure your video resolution is set accordingly.

B. Click Change Display Type. On the following screen, check the Adapter Type, Manufacturer, and
Version.



Do you have the current version of the video drivers? As most companies update their drivers several
times a year, The Learning Company recommends checking with the video card manufacturer or 
computer company regularly. Earlier software drivers for your video card can cause conflicts (GPF's,
Lockups, and so on) with the software you are running.

Note: Windows95 video drivers start with version 4.00.

Does the Adapter Type listed match the name of your video card? Does the Manufacturer match the 
name of your video card manufacturer? Most video card drivers are named after the name brand of the 
card. If the driver listed is not the name of your video card and/or the manufacturer of the driver is not the 
manufacturer of your video card, you may be using the wrong driver. Contact your video card 
manufacturer or computer company for verification.Hardware Manufacturers 

7. DEVICE MANAGER CONFLICTS

On your Windows screen, right-click the My Computer icon. Now click Properties. The System 
Properties window appears. Click the Device Manager tab.



The Device Manager shows all hardware in your machine that is recognised by Windows. Look for a 
yellow exclamation point next to one or more of the hardware components listed here. A yellow 
exclamation mark essentially indicates that the device is not working properly; either because it was setup
incorrectly or because of a conflict with something else on the system. In such a case, you should contact
your computer retailer or manufacturer of the device in question for further assistance.

8. CHECKING THE SWAP FILE

Step 7 took you to the System Properties window (right-click My Computer, then click Properties). Now 
click the Performance tab. Click the Virtual Memory button. Make sure the following option is checked:
|X| Let Windows manage my virtual memory settings (recommended).



9. DELETE AND REINSTALL

After everything has been checked, verified, and changed if necessary, it's time to delete and reinstall the 
program. If the program installed incorrectly or became unstable after it was installed, reinstalling on top 
of the program keeps that instability. Therefore it's important to uninstall or delete the program from the 
hard drive before reinstalling.

TO REMOVE A WINDOWS 95/98 NATIVE PROGRAM

Insert the CD and select Uninstall from the program's splash screen.

Alternatively the following options may be available:

Click from the Start menu, to Programs, to the program title folder. Once the program's icons 
appear, click the Uninstall icon. Follow the onscreen directions.

Click from the Start menu, to Settings, to Control Panel and double-click on the Add/Remove 
Programs icon. Then double-click on the relevant title.

TO REMOVE A WINDOWS 3.x PROGRAM

Open My Computer, double-click the hard drive icon, and drag the The Learning Company program title 
folder to the Windows Recycle Bin.

Note: The program files will not be fully erased until you empty the Recycle Bin. To empty the Recycle 
Bin, right-click it and choose Empty Recycle Bin.

If you are still encountering problems please try: 
Other Useful Information 



If your problem is related to graphical corruption please also try the following:
HARDWARE ACCELERATION 

On your Windows screen, right-click the My Computer icon. Now click Properties. The System 
Properties window appears. Click the Performance tab, followed by Graphics.

Try each of the four options in turn as this can sometimes prevent graphical errors.
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General Windows 3.1 Trouble Shooting
This topic presents some steps you can take before you contact Technical Support. Please open the File 
menu and click Print Topic. A hard copy of this topic is useful, since you will be working with your system 
and restarting your computer.

Before starting this guide please ensure that your machine meets the minimum system requirements 
stated on the Learning Company software package.

*********************************** CAUTION - DISCLAIMER ***********************************
NOTICE: The Learning Company, Inc. will not be responsible for any damage or other consequences 
resulting from changes made to system configuration files. You make any changes at your own risk. Even 
if you are familiar with modifying your system and/or files, we recommend you make backup copies of any
files you intend to modify.
*********************************** CAUTION - DISCLAIMER ***********************************

Please Note: The following system files listed in this troubleshooting guide are examples only and may differ from 
the actual files in your machine.

STEP 1. CHECKING THE SYSTEM FILES

CAUTION: The following steps will walk you through the editing of some of your computer's configuration 
files. When modifying your system files, caution should be used.

From the File menu, select Run. In the command line, type C:\WINDOWS\SYSTEM\SYSEDIT and press 
Enter.

SYSEDIT displays the contents of your AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, and SYSTEM.INI.



A. Checking the AUTOEXEC.BAT file.

In the AUTOEXEC.BAT, see if you have a SET TEMP= statement. Some examples of what they might 
look like are:

SET TEMP=C:\WINDOWS\TEMP
SET TEMP=C:\DOS\TEMP
SET TEMP=C:\TEMP

If the SET TEMP= line is listed in your AUTOEXEC.BAT, make sure that it points to a "unique" directory 
name like "TEMP" and not an application directory like C:\DOS or C:\WINDOWS. If the SET TEMP= 
statement is not in your AUTOEXEC.BAT, then one will need to be created. Add the line

SET TEMP=C:\TEMP

to your AUTOEXEC.BAT. It can appear anywhere in your AUTOEXEC.BAT, but if your machine 
automatically boots into Windows when you turn it on, be sure this line appears before the WIN 
command.

Also make sure this "unique" directory name exists on the hard drive. For the SET TEMP= line to work, 
the directory must also exist. Verify the directory exists by doing the following:

1. Go into File Manager:
A. Go into the Main group from Program Manager.
B. Double-click on File Manager.
The directories of drive C: should appear on the left side of the screen. 

2. Look for a directory with the same path and name as the one which follows SET TEMP=.

Example: If SET TEMP=C:\TEMP is in your AUTOEXEC.BAT:

A. In the File Manager, look for the folder called TEMP.
B. If this does not exist, then click on the File pulldown menu and select Create Directory. 
C. Now type in the name of the "unique" directory as listed in the SET TEMP= line. For the 

example above, you would type in TEMP. 
D. Save changes, using the System Configuration Editor File menu, Save command. 



B. Checking the CONFIG.SYS file.

In the CONFIG.SYS, look for the FILES= and BUFFERS= lines. They should be set to FILES=30 and 
BUFFERS=30,0. These values can be higher, but lower values could cause memory problems.

Save changes, using the System Configuration Editor File menu, Save command.

C. Checking the WIN.INI file.

In the WIN.INI, under the [WINDOWS] section, look for the LOAD= and RUN= lines. When Windows 
loads up, these lines may load up extra drivers or programs into Windows that might not show up in the 
Task List (Task List is addressed in Step 6).

If these lines are not empty, then temporarily REMark them out. At the beginning of the line place a 
semicolon (;)

Example:
LOAD=C:\MSINPUT\POINTER.EXE NAVTSR

becomes
;LOAD=C:\MSINPUT\POINTER.EXE NAVTSR



NOTE:    The same procedure applies to the RUN= line.

Save changes, using the System Configuration Editor File menu, Save command.

STEP 2. GETTING INTO DOS

The next troubleshooting step is performed outside of Windows. To exit Windows: from the File menu, 
select Exit Windows.

NOTE: Do not use the DOS Prompt icon from the Main group.

Once out of Windows, you should be in DOS with a DOS prompt (C:\>) on your screen.

STEP 3. CHECKING THE HARD DRIVE FOR PROBLEMS

Run SCANDISK or CHKDSK on the C: drive (and the drive where this program is installed to if it is not 
drive C:). Scandisk requires Microsoft DOS version 6 or higher. If you do not have MS DOS version 6 or 
higher, run CHKDSK. To find out what version of DOS you are using, type VER and press Enter.

To run Scandisk, type SCANDISK and press Enter.

To run CHKDSK, type CHKDSK /F and press Enter.

Fix any problems detected.
[Check your DOS manual for more information on these DOS commands.]

STEP 4. RESTART MACHINE

Even if you didn't make any changes, restart your machine now. Use Ctrl+Alt+Del or the reset switch on 
your computer, and go back into Windows. Once Windows starts to load, hold down the left Shift key, 
until Windows fully loads. This helps prevent some memory resident programs from loading into 
Windows.

STEP 5. CHECKING MEMORY AND RESOURCES

From Program Manager, click the Help menu, select About Program Manager. 



Verify the Following:

A. You are running in 386 Enhanced Mode. This is automatic for Windows for Workgroup users.

B. Memory is at least 8,000 KB free. 

C. System Resources should be 78% or higher.

Click OK on the screen to close the About Program Manager.

STEP 6. CHECKING THE TASK LIST

This step will check for other programs running in the background. This is the most common cause of 
problems you may encounter. To open the Task List, press Ctrl+Esc. 

If the Task List lists anything other than Program Manager, highlight the item and click the End Task 
button. This temporarily unloads the program from memory, until you restart Windows. Repeat this 
procedure as necessary, until only Program Manager is left.

STEP 7. CHECKING THE VIDEO DISPLAY DRIVER



From the Main group, double-click Windows Setup. Look at the line entitled Display.

NOTE: Take extreme caution in making any changes to your video card drivers. Unless you are familiar 
with changing your display driver, The Learning Company strongly recommends following the 
instructions as outlined in your video card manual or contacting the video card manufacturer or 
computer company for assistance. If you choose a incorrect video card driver, you may find your 
Windows screen corrupted.

A. Is the resolution / colours set correctly to run the program? Most Learning Company programs run in 
either 640x480 256 colours or 800x600 256 colours. Check the system requirements for the Learning 
Company program you are running and make sure your video resolution is set accordingly. 

NOTE:    Some video card drivers do not display the resolution / colours, refer to your video card 
documentation for more information.

B. Does the driver name listed match the name of your video card? Most video card drivers are named 
after the name brand of the card. If the driver listed is not the name of your video card, you may be 
using the wrong driver. Contact your video card manufacturer or computer company for verification. 

C. Do you have the current version of the video drivers? As most companies update their drivers 
several times a year, The Learning Company recommends checking with the video card manufacturer
or computer company regularly. Hardware Manufacturers Earlier software drivers for your video 
card can cause problems (GPF's Lockups, and so on) with the software you are running. 

STEP 8. CHECKING VIRTUAL MEMORY

The following instructions require MS DOS version 6 or higher. If you do not have MS DOS 6 in your 
machine, skip this step.

From Program Manager, click from the Main group, to Control Panel, to 386 Enhanced, to the Virtual 
Memory button. Write down the Swapfile Settings Drive, Size and Type.

Example:
Drive: C:, Size: 8,127 KB, Type: Permanent.



1. Click the Change>> button and on the following screen, reduce the Swap File Size to 0 (zero).

2. Exit Windows as before in Step #2. At the DOS prompt (C:\>) type Defrag and press Enter. (Defrag is
a MS DOS 6 utility program that will unfragment the information stored on the hard drive. Once 
Defrag is completed, go back into Windows.) 

3. Return to the Virtual Memory screen (Click from the Main group, to Control Panel, to 386 Enhanced,
to the Virtual Memory button). Click Change>> and restore your Swapfile Settings. 

NOTE:    A Permanent Swapfile will provide better performance over a Temporary Swapfile. For optimal 
performance, The Learning Company recommends setting a Permanent Swapfile to no less than 
8 MB. (19mb Swapfile should be used for '8mb RAM' PCs)

STEP 9. DELETE AND REINSTALL

Before doing the following, repeat Step 6 (Checking the Task List).

After everything has been checked, verified, and changed if necessary, it's time to delete and reinstall the 
program. If the program installed incorrectly or became unstable after it was installed, installing on top of 
the program will keep that instability. Therefore it's important to delete the program from the hard drive 
before reinstalling. This includes all icons.

NOTE:    Newer Learning Company titles come with Uninstall programs that automatically perform the 
procedure outlined below. Check your Learning Company Program Group for an Uninstall icon, 
or. read your program documentation for more information.

1. From Program Manager, open the Main group, double-click the File Manager.
2. Find the Learning Company program title folder and click it one time to highlight it.
3. From the File menu, select Delete.



If you are unsure of the directory name the program was installed to, check the Learning Company 
manual, Online help or QuickStart card.

4. From the File menu, select Exit.
5. Open the Learning Company program title icon group from the Windows desktop.
6. Click the Learning Company program icon one time to highlight it.
7. From the File menu, select Delete.
8. Repeat this procedure as necessary, until all Learning Company program icons are deleted. 
9. Reinstall the program. 

Contents 



Hardware Manufacturers
Contact details for some hardware manufacturers, if your manufacturer is not listed please contact your 
PC's supplier for advice.

Acer:
http://www.acer.com

ATI:
http://support.atitech.ca
Telephone:    00353 1 807 7826 (Ireland)

Aztech Labs:
http://www.aztechca.com/
Telephone: +44 (0)1189 814121(UK)

Cirrus Logic:
http://www.cirrus.com/ 

Compaq:
http:// www.compaq.com

Creative Labs:
http://www.creativelabs.com

Dell:
http://www.dell.com

Diamond:
http://www.diamondmm.com
Telephone: +44 (0)1189 444 444 (UK)

Ensoniq:
http://www.ensoniq.com

Gateway:
http://www.gw2k.com

Gravis:
http://www.gravis.com

Hercules:
http://www.hercules.com/

HP:
http://www.hp.com

IBM:
http://www.ibm.com

Matrox:
http://www.matrox.com/



Miro:
http://www.miro.com/
Telephone: +44 (0)1895 442003 (UK) 

Oak Technologies:
http://www.oaktech.com 

Orchid:
http://www.orchid.com

Packard Bell:
http://www.packardbell.com

S3:
http://www.s3.com/ 

STB:
http://www.stb.com
Telephone: +44 (0)181 897 0662 (UK)

Toshiba:
http://www.toshiba.com

Trident:
http://www.tridentmicro.com

Tseng:
http://www.tseng.com
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Other Useful Information

Please also refer to any 'readme' files that may be located on the CD.

------------------------------------------

Text is Illegible:

Certain Lotus or IBM products, such as Lotus Wordpro, install a font that interferes with the fonts used by 
Windows 95/98. This problem can be resolved by removing the Monotype Sorts Font
version 2.0 from your system. 

To remove the font, click on the Windows 95/98 "Start" menu, select "Settings", then select "Control 
Panel". In the resulting window, double-click on the "Fonts" icon. In the resulting list
of fonts, find "Monotype Sorts Font" (sometimes listed as "Mtsorts_.ttf") and remove it by dragging it into 
the Windows 95/98 recycle bin on your desktop.

------------------------------------------

Video/Movies do not play: Cannot find "vids.IV32" decompression:

To address this problem, click on the Windows 95/98 "Start" menu, select "Settings", then select "Control 
Panel". In the resulting window, double-click on the "Add/Remove Programs" icon, then click on the 
"Windows Setup" tab. Scroll down in the list to "Multimedia" and double-click on it. In the new list that 
appears, scroll to "Video Compression" and make sure that the box next to it is checked. Click on the 
"OK" button, then click on "OK" again.

When you change these settings, you may have to re-start Windows 95/98 in order for the changes to 
take effect. Click on "Yes" if offered this option.

------------------------------------------

Inaccurate planetarium:

If you find that the planetarium changes the latitude and longitude of the viewing location when the 
program is closed down and restarted. This will be evident by the program reporting different information 
to that which is actually seen in the sky.

The solution is to bring up the location dialog and click on some location other than the one you require, 
then click back on the location that you wish to view from. This will set the viewing position correctly until 
the program is closed.
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Contacting Technical Support

Have you completed all the steps detailed?

Many issues can be solved by referring to the help within this guide.
General Windows 3.1 Trouble Shooting 
General Windows 95/98 Trouble Shooting 
Other Useful Information.

If you have any further questions, please contact us at the office nearest you:

USA 
United Kingdom 
France 
Germany 
The Netherlands 
Australia 
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United Kingdom

Tech Support e-mail: uksupport@learningco.com

Phone: 09062165432 (Calls cost 25p/min & may be monitored/recorded. Correct at Apr 1999)
Facsimile: 09062165433 (All calls cost 25p/min. Correct at Apr 1999)

Mail: The Learning Company
PO Box 121
Crawley
RH11 9YP
ENGLAND
Attn:    <product name>

We regret that we cannot offer game hints and tips, as the service is provided for technical difficulties 
only.
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USA
Online Support Request Form:    www.learningco.com

Technical Support Email:    help@tlcsupport.com

Online Technical Library:    www.learningco.com/support

Automated 24-hour 
Technical Support Service: 800-409-1497

24 Hour Fax:    319-395-9600

Technical Support Call Center:    319-247-3333 
Business Hours:    9:00 AM - 9:00 PM

Mailing Address
The Learning Company
1700 Progress Drive
PO Box 100
Hiawatha, IA 52233-0100    USA
Attn:    <product name>
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Germany
Keltenring 12
82041 Oberhaching
Germany

Tel ++49 89/613 092 35    
Fax ++49 89/14827-411

email hotline@learningco.com
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The Netherlands
PO Box 94791
1090 GT Amsterdam
The Netherlands

Tel 0900 8524357

email nsupport@learningco.com
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France

132 bvd Camelinat
92247 Malakoff Cedex
France

Tel: +33 1 46 73 08 00
e-mail: supportfr@learningco.com
Web : http://tlc-edusoft.fr
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Australia

Phone: 61-2-9899-2277
Facsimile: 61-2-9899-2348    
Mail: Unit 6

372 Eastern Valley Way
Chatswood
Sydney
NSW 2067
Australia
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